AUTOMATION OF LIGHT INTENSITY USING ARDUINO

H. Antony1, S. Anusha2, K. jeevitha3, G. Rasi priya4

1Assistant Professor,
2,3,4Department of Electronics and Communication Engineering,
1,2,3,4J.N. N Institute of Engineering Chennai, India

Abstract—This paper proposes a micro-IoT architecture for lighting and dimming control in smart homes. The proposed solution integrates not only open software platforms on front-end devices and the cloud server, but also presents hardware specifications to lighting control equipment. Prototypical development exhibits scenarios, usages and real testing data. Results show our design can attain low energy consumption and high accuracy of dimming ratio in regard to cloud-based lighting control services.

Keywords: Lighting control, home automation, smart home, cloud service, Internet of Things (IoT).

I. INTRODUCTION
Luminous flux is an attribute of perception within which supply seems to radiate or mirror light weight
“Brightness” could be a non-quantitative term that’s usually accustomed describe this characteristic.
Luminous flux is measured in lumen and is that the light-weight power measured increased with the V-λ scaling perform that compensates for the human eye’s sensitivity totally different wavelengths.
The radiant flux of LEDs is essentially ruled by this flowing through the device. Fig.
1 shows a typical curve characteristic of an LED light emitting diode (luminous flux versus the current).

Fig. 1: LED Current vs. Luminous Flux [1] Another variable that plays a major role within the quantity of radiant flux of the light emitting diodes is that the temperature of the light emitting-diode device.
Thus, its vital management to regulate to manage the temperature of these devices so as to keep us full control.

Fig. 2 shows the link between the forward voltage and also the forward current of an LED light.
As expected, the light emitting diode encompasses a threshold forward voltage on the far side that it enables current to flow through it.
Once the light emitting diode voltage reaches its threshold worth, its current becomes an exponential function of its voltage.

Power Supply:
Alternating current (AC) is employ for transmission line transmission and for prime power devices like appliances and lights.
The characteristics of AC build it ideal for transmission over long lines and for delivering gaint amounts of power for comparatively unregulated uses, such as generating heat and light.
Lower power appliances and devices need the closely regulated management of electrical energy power (DC).
As a traditional home is furnished AC, it be reborn to DC for several uses.
Use the following tips to be told the build associate degree AC DC device.

A transformer contains 2 magnetically coupled wire windings. One winding is called the primary.
The primary is driven by the most AC provide. The other winding is called the secondary.
The secondary is the facility input to the AC DC device. This electrical device and every one of the opposite things required to create the AC DC device square measure without delay obtainable at electronic stores and hobby stores.
• Size the transformer windings. AC mains provide 120 volts AC.
If a hundred and twenty volts AC were directly reborn to a DC voltage, the resulting DC voltage would be far too high a voltage for use by appliances and devices.
The primary and secondary windings of the transformer are scaled to each other in order to produce a lower voltage on the secondary winding.
• Choose a secondary winding.
The AC output of the coil ought to be rated because the same voltage of DC that being created.
Wire the first winding of the electrical device to the most AC provide.
This electrical device association has no polarity and will be connected either manner.
Connect the coil of the electrical device to a full wave bridge rectifier package.
The electrical device connections and also the connections to the marked inputs of the rectifier package haven’t any polarity and will be connected either manner.
A transformer contains 2 magnetically coupled wire windings. One winding is called the primary. The primary is driven by the main AC supply. The other winding is called the secondary. The secondary serves as the power input to the AC DC converter. This transformer and all of the other items needed to build the AC DC converter are readily available at electronic stores and hobby stores.

- Size the transformer windings. AC mains provide 120 volts AC. If 120 volts AC were directly converted to a DC voltage, the resulting DC voltage would be far too high a voltage for use by appliances and devices. The primary and secondary windings of the transformer are scaled to each other in order to produce a lower voltage on the secondary winding.
- Choose a secondary winding. The AC output of the secondary winding should be rated as the same voltage of DC that is being created. Wire the primary winding of the transformer to the main AC supply. This transformer connection has no polarity and may be connected either way.

**FIG 1.2 BRIDGE RECTIFIER**

Connect the secondary winding of the transformer to a full wave bridge rectifier package. The transformer connections and the connections to the marked inputs of the rectifier package have no polarity and may be connected either way.

- Build a full wave rectifier.
- This rectifier may be engineered up from four distinct rectifying diodes, rather than using a rectifier bridge package.
- The diodes are marked to point out a positive (cathode) finish and a negative (anode) finish.

Connect the 4 diodes into a loop. Connect the cathode of diode one to the cathode of diode a pair of. Connect the anode of diode a pair of to the cathode of diode three. Connect the anode of diode 3 to the anode of diode 4. Connect the cathode of diode 4 to the anode Attach a smoothing capacitor. Attach a polarized capacitor across the output connections of the rectifier. The positive terminal of the polarized condenser should hook up with the positive output of the regulator. This condenser ought to be sized specified the capacitance in farads (F) is capable (5 times this to be equipped by the AC DC converter) divided by (transformer secondary rating times 1.4 times frequency). Frequency varies from country to country, but is typically either 50 Hertz (Hz) or 60 Hertz. Provide the final regulation. Choose a commercially out their transformer designed to manage the output of the AC DC device to the required output voltage.

The regulator will be a 3-pin device. The regulator pins are a typical, an input from the smoothing capacitor and an output of the regulator. This regulator output additionally are the ultimate output of the finished AC DC device.

**2. ARDUINO MICRO CONTROLLER**

**Pin Description**

<table>
<thead>
<tr>
<th>Pin Category</th>
<th>Pin Name</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Vin, 3.3V, 5V, GND Vin</td>
<td>Input voltage to Arduino when using an external power source. 5V: Regulated power offer accustomed power microcontroller and alternative parts on the board.</td>
<td></td>
</tr>
<tr>
<td>3.3V: 3.3V supply generated by on-board voltage regulator. Maximum current draw is 50mA. GND: ground pins.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the microcontroller.</td>
<td></td>
</tr>
<tr>
<td>Analog Pins A0 – A5</td>
<td>Used to provide analog input in the range of 0-5V</td>
<td></td>
</tr>
<tr>
<td>Input/Output Pins Digital Pins 0 - 13</td>
<td>Can be used as input or output pins.</td>
<td></td>
</tr>
<tr>
<td>Serial 0(Rx), 1(Tx)</td>
<td>Used to receive and transmit TTL serial data.</td>
<td></td>
</tr>
<tr>
<td>External Interrupts 2, 3</td>
<td>To trigger an interrupt.</td>
<td></td>
</tr>
<tr>
<td>PWM 3, 5, 6, 9, 11</td>
<td>Provides 8-bit PWM output.</td>
<td></td>
</tr>
<tr>
<td>SPI 10 (SS), 11 (MOSI), 12 (MISO) and 13 (SCK)</td>
<td>Used for SPI communication.</td>
<td></td>
</tr>
<tr>
<td>Inbuilt LED 13</td>
<td>To turn on the inbuilt LED.</td>
<td></td>
</tr>
<tr>
<td>TWI A4 (SDA), A5 (SCA)</td>
<td>Used for TWI communication.</td>
<td></td>
</tr>
<tr>
<td>AREF</td>
<td>To provide reference voltage for input voltage.</td>
<td></td>
</tr>
</tbody>
</table>

Arduino Uno Technical Specifications
Microcontroller ATmega328P – 8 bit AVR family microcontroller
Operating Voltage 5V
Recommended Input Voltage 7-12V
Input Voltage Limits 6-20V
Analog Input Pins 6 (A0 – A5)e of diode 1.

Other Arduino Boards
Arduino Nano, Arduino Pro Mini, Arduino Mega, Arduino Due, Arduino Leonardo
Arduino Uno to ATmega328 Pin Mapping
When ATmega328 chip is used in place of Arduino Uno, or vice versa, the image below shows the pin mapping between the two.

Programming Arduino
Once arduino IDE is installed on the computer, connect the board with computer using USB cable. Now open the arduino IDE and choose the correct board by selecting Tools>Boards>Arduino/Genuino Uno, and choose the correct Port by selecting Tools>Port. Arduino Uno is programmed using Arduino programming language based on Wiring. To get it started with Arduino Uno board and blink the built-in LED, load the example code by selecting File>Examples>Basics>Blink. Once the example code (also shown below) is loaded into your IDE, click on the ‘upload’ button given on the top bar. Once the upload is finished, you should see the Arduino’s built-in LED blinking. Below is the example code for blinking.

```cpp
// the setup function runs once when you press reset or power the board
void setup() {
  // initialize digital pin LED_BUILTIN as an output.
  pinMode(LED_BUILTIN, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
  digitalWrite(LED_BUILTIN, HIGH);   // turn the LED on (HIGH is the voltage level)
  delay(1000);                       // wait for a second
  digitalWrite(LED_BUILTIN, LOW);    // turn the LED off by making the voltage LOW
  delay(1000);                       // wait for a second
}
```

Applications
- Prototyping of Electronics Products and Systems
- Multiple DIY Projects.

What is NodeMcu ESP8266?

NodeMcu
NodeMcU is an open source IoT platform. Which includes firmware which runs on the ESP8266 Wi-Fi Module from Espressif Systems, and hardware which is based on the ESP-12 module. The term “NodeMcu” by default refers to the firmware rather than the dev kits. NodeMcu firmware was developed so that AT commands can be replaced with Lua scripting making the life of developers easier. So it would be redundant to use AT commands again in NodeMCU.NodeMcu ESP8266

ESP8266 Feature:
- Open-source
- Interactive
- Programmable
• Low cost
• Simple
• Smart
• WI-FI enabled

Advantages
• Low energy consumption
• Integrated support for WIFI network
• Reduced size of the board
• Low Cost

Disadvantages
• Need to learn a new language and IDE
• Less pinout

NODEMCU PIN OUT:

NODEMCU_DEVKIT_V1.0_PINMAP

HOW TO PROGRAM IT:
• Install the current upstream Arduino IDE at the 1.8 level or later. The current version is at the Arduino website.
• Start Arduino and open Preferences window.
• Enter https://arduino.esp8266.com/stable/package_esp8266com_index.json into Additional Board Manager URLs field. You can add multiple URLs, separating them with commas.

After Complete
1. Data Cable of your Mobile Phone. Used in To Connect ESP8266 MCU NODE with PC.
2. After Install Drivers if Needed.
3. Check Which Number Is Assigned To your Board.
4. Open Arduino IDE.
5. Upload Example
6. Open Boards Manager from Tools
   > esp8266Modules platform And Select NodeMCU 1.0(ESP-12E Module) board from Tools.
   • Upload Using : Serial
   • CPU Frequency : 80Mhz
   • Flash Size: 4M
   • Upload Speed: 115200
   • PORT: Select Assign Port Only.
Connected with Cable and Check COM PORT NUMBER

FIG 2.1 USB PORT

Setting in Arduino IDE
Then UPLOAD IT.

3 AC Dimmer Module
Ac Phase Angle Control, serial + binary control, Suitable for resistive and light inductive load like Ceiling fans.
Control dimming from Parallel input or Serial Data input. The control part is totally isolated from high voltage by on board opt couplers.

This board is very much improvement over our earlier 16 step board allowing more smooth control in dimming due to more steps.

The board can be used in applications where dimming of 110-220V AC power is required like dimming of resistive loads and light inductive load (like ceiling fan, do not try to use it with heavy loads like AC, Motors, halogen, transformers). The input can be simple 8-bit binary signal from microcontroller which is isolated with the use of opto-couplers or serial data input.

Total of 256 levels of power control can be set from totally off (0%) to full on (100%) as per input control levels.

Features
- AC Phase Angle Control Dimming
- Simple to use with any microcontrollers
- Output can switch on AC Load up to 12 Amp
- Output is optically isolated from input
- 256 Levels of Control

AC Load Type  Bulb (Resistive Load) up to 1000 Watts
Fan (Inductive Load) unto 100 Watts

Frequency of mains 50 Hz or 60 Hz

Control Input Voltage 5V DC Isolated

Theory of Operation
In this dimmer, the alternating current (AC) phase control method is used to control the intensity of an incandescent lamp or fan, which is connected as a load. The rms value of the voltage supplied to the lamp is varied by controlling the firing angle of a Triac. The firing angle is the time the Triac is made on. The firing angle is determined by the control input. By controlling the firing angle, the rms voltage supplied to the load changes and according to the voltage light intensity of the bulb varies. Figure displays the effective voltage applied to a load by controlling the firing angle, $\alpha$.

Controlling Input - Parallel method
The input to board is simple 8-bit binary input of HIGH/LOW signal from microcontroller. There are eight inputs to board D0-D7. Each data control line needs to be now made either HIGH or LOW as per dimming required. The binary input is inverted. All parallel inputs have internal pull high. So if kept floating they all have value of 0xFF (255) which is off level. If full level is required, all inputs are to be pulled low 0x00(0), you can then input any binary signal from 0x00 to 0xFF (0-255 decimal) to control the dimming.

- Ground signal has to be common with external control board along with parallel inputs

Controlling Input - Serial method
The input to board is simple one-byte character from microcontroller or PC. If byte 0 is sent then dimming is off, if byte 0xFF is sent it gives full level of brightness. Anything in between 0x00 to 0xFF is sent then it gives different levels of dimming.

### Specification

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC Input</td>
<td>80V AC to 250V AC</td>
</tr>
<tr>
<td>AC Load Current</td>
<td>12 Amp Maximum</td>
</tr>
<tr>
<td>AC Load Type</td>
<td>Bulb (Resistive Load) up to 1000 Watts</td>
</tr>
<tr>
<td></td>
<td>Fan (Inductive Load) up to 100 Watts</td>
</tr>
<tr>
<td>Frequency of mains</td>
<td>50 Hz or 60 Hz</td>
</tr>
<tr>
<td>Control Input Voltage</td>
<td>5V DC Isolated</td>
</tr>
</tbody>
</table>

**FIG 3.0 DIMMER MODULE**

Ground signal has to be common with external control board along with parallel inputs. While controlling with serial method, keep all D0-D7 pins floating, and do not use it. If any pin from parallel is kept at low level then Serial inputs will be ignore.

4. **LCD**

LCD (Liquid Crystal Display) screen is an electronic display module and find a wide range of applications. A 16x2 LCD display is very basic module and is very commonly used in various devices and circuits. These modules are preferred over seven segments and other multi segment LEDs. The reasons being: LCDs are economical; easily programmable; have no limitation of displaying special & even custom characters (unlike in seven segments), animations and soon.

A 16x2 LCD means it can display 16 characters per line and there are 2 such lines. In this LCD each character is
displayed in 5x7 pixel matrix. This LCD has two registers, namely, Command and Data.

The command register stores the command instructions given to the LCD. A command is an instruction given to LCD to do a predefined task like initializing it, clearing its screen, setting the cursor position, controlling display etc. The data register stores the data to be displayed on the LCD. The data is the ASCII value of the character to be displayed on the LCD.

### FIG 4.1 LCD PIN DIAGRAM

#### Pin Description:

<table>
<thead>
<tr>
<th>Pin No</th>
<th>Function</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground (0V)</td>
<td>Ground</td>
</tr>
<tr>
<td>2</td>
<td>Supply voltage; 5V (4.7V – 5.3V)</td>
<td>Vcc</td>
</tr>
<tr>
<td>3</td>
<td>Contrast adjustment; through a variable resistor</td>
<td>( V_{EE} )</td>
</tr>
<tr>
<td>4</td>
<td>Selects command register when low; and data register when high</td>
<td>Register Select</td>
</tr>
<tr>
<td>5</td>
<td>Low to write to the register; High to read from the register</td>
<td>Read/write</td>
</tr>
<tr>
<td>6</td>
<td>Sends data to data pins when a high to low pulse is given</td>
<td>Enable</td>
</tr>
<tr>
<td>7</td>
<td>8-bit data pins</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Backlight Vcc (5V)</td>
<td>Led+</td>
</tr>
<tr>
<td>16</td>
<td>Backlight Ground (0V)</td>
<td>Led-</td>
</tr>
</tbody>
</table>

#### Control Signals

**RS- Register Select**

There are 2 very important registers in LCD

- Command Code register
- Data Register
- RS=0 \( \rightarrow \) Instruction command Code register is selected, allowing user to send command

- RS=1 \( \rightarrow \) Data register is selected allowing to send data that has to be displayed.
- RW- Read/Write
- RW input allows the user to write information to LCD or read information from it. How do we read data from LCD? The data that is being currently displayed will be stored in a buffer memory DDRAM. This data could be read if necessary.

- If
- R/W=0 \( \rightarrow \) Reading
- R/W=1 \( \rightarrow \) Writing
- E- Enable
- The enable Pin is used by the LCD to latch information at its data pins. When data is supplied to data pins, a high to low pulse must be applied to this pin in order for the LCD to latch the data present in the data pins.

- E \( \rightarrow \) Toggle
- Data Bus- D0-D7
- Power for Backlighting LEDs
- VDD-Power 5V
- Vss- GND

#### Various Commands used in LCDs

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Data</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Function Set: 0-bit, 1 Line, 5x7 Dots</td>
<td>0x00</td>
<td>40</td>
</tr>
<tr>
<td>2</td>
<td>Function Set: 0-bit, 2 Lines, 5x7 Dots</td>
<td>0x09</td>
<td>56</td>
</tr>
<tr>
<td>3</td>
<td>Function Set: 4-bit, 1 Line, 5x7 Dots</td>
<td>0x20</td>
<td>20</td>
</tr>
<tr>
<td>4</td>
<td>Function Set: 4-bit, 2 Lines, 5x7 Dots</td>
<td>0x20</td>
<td>20</td>
</tr>
<tr>
<td>5</td>
<td>Entry Mode</td>
<td>0x30</td>
<td>40</td>
</tr>
<tr>
<td>6</td>
<td>Display off/On; Clearing display without clearing DDRAM contents</td>
<td>0x00</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>Display on/On</td>
<td>0x02</td>
<td>16</td>
</tr>
<tr>
<td>8</td>
<td>Display on/Off</td>
<td>0x0C</td>
<td>12</td>
</tr>
<tr>
<td>9</td>
<td>Display on/Off</td>
<td>0x0F</td>
<td>15</td>
</tr>
<tr>
<td>10</td>
<td>Shift right/display left</td>
<td>0x3F</td>
<td>24</td>
</tr>
<tr>
<td>11</td>
<td>Shift left/displaay right</td>
<td>0x3C</td>
<td>20</td>
</tr>
<tr>
<td>12</td>
<td>Move cursor left by one character</td>
<td>0x10</td>
<td>16</td>
</tr>
<tr>
<td>13</td>
<td>Move cursor right by one character</td>
<td>0x44</td>
<td>20</td>
</tr>
<tr>
<td>14</td>
<td>Clear Display (also clear DDRAM contents)</td>
<td>0x01</td>
<td>1</td>
</tr>
</tbody>
</table>

#### 5. Crystal Oscillator

A quartz crystal resonator plays a vital role in electronics oscillator circuitry. Sometimes mispronounced as crystal oscillator, it is rather a very important part of the feedback network of the oscillator circuitry. Electronics oscillators are used in frequency control application finding their usage in almost every industry ranging from small chips to aerospace.

A quartz crystal is the heart of such type of resonators. Their characteristics like high quality factor (Q), stability, small size an low cost make them superior over other resonators like LC circuit, turning forks, ceramic resonator etc.

The basic phenomenon behind working of a quartz crystal oscillator is the inverse piezo electric effect i.e., when electric field is applied across certain materials they start producing mechanical deformation. These mechanical
Deformation/movements are dependent on the elementary structure of the quartz crystal. Quartz is one of the naturally occurring materials which show the phenomena of piezoelectricity, however for the purpose of resonator it is artificially developed since processing the naturally occurring quartz is difficult and costly process.

![Image](FIG4.1 OSCILLATOR)

The image above shows a commonly used quartz crystal resonator. It is widely used in electronic oscillators circuitry used in digital circuits and microcontroller/processors.

5. Capacitor

![Image](FIG 5.1 CAPACITOR)

Capacitor is a passive component used to store charge. The charge (q) stored in a capacitor is the product of its capacitance (C) value and the voltage (V) applied to it. Capacitors offer infinite reactance to zero frequency so they are used for blocking DC components or bypassing the AC signals. The capacitor undergoes through a recursive cycle of charging and discharging in AC circuits where the voltage and current across it depends on the RC time constant. For this reason, capacitors are used for smoothing power supply variations. Other uses include, coupling the various stages of audio system, tuning in radio circuits etc. These are used to store energy like in a camera flash.

![Image](FIG 5.1 PIN DIAGRAM)

**Pin Diagram:**
Capacitor is a widely used electronic component. It stores electric charge and then discharges it into the circuit. It blocks the direct current and allows the alternating current to pass through it. Depending on the purpose, there are a variety of capacitors being used like ceramic, electrolytic, Mylar, mica, etc. We will explore an electrolytic capacitor through this article.

**VI. CONCLUSION**
In this paper, we proposed a key generation mechanism for sharing the data in wireless environment. Here scalar multiplication on elliptical curves reduces the overhead and thereby increasing the throughput and efficiency. The analysis explained the security by reducing the time overhead to improve the efficiency in IOT.

**VII. REFERENCES**